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Tutorial Outline

 SyncML-DM : an Approach for
Managing Dynamic Devices

— Representation Protocol for Device
Management

— Device Management Protocol
— Standardized Objects

— Device Management Tree

— MAD-MAX Toolkit

— Benchmarkings
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Towards open data synchronization

2000: creation of the SyncML consortium (www.syncml.org).

Members : More than 600 companies-IBM, Nokia, Motorola,
Ericsson, Matsushita, Symbian, Openwave .....

Objective : Develop an Open Standard for data
Synchronization

Additional Results : Device Management Framework for
managing devices .

Synchronization Markup Language is an Open Specification
for universal synchronization

@ MADYNES 2003



Use cases for Device Management

*Over the air Mass Configuration

Remote service management
Personal Management
Storage Management
Monitoring

Software download
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Challenges in Device Management
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Requirements for Device Management

« QOperate effectively over wireless and wired networks
e Support a variety of transport protocols

« Support arbitrary networked data

« Enable data access from a variety of applications

» Address the resource limitations of the mobile device

* Build upon existing Internet and Web technologies
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Wireless/Wired Network Operations

Ubiquitous wireless access

1. High network latency
2.  Limited bandwidth

3. Low reliability of both data
and connectivity

4. Dynamic Addresses and
network connectivity

5. Firewall, Nats — several
management domains

6. Out of coverage factors

b

Redefine Management

Management might be to late

Manage efficiently (whenever
it's required without wasting
resources)

Connection Oriented
management

Application level naming and
addressing

Device initiated management

Different Fault behavior
management
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Scope of SyncML

i

Client
Application

XML based framework for
data synchronization

Message oriented data
exchange protocol

Transport agnostic
Universal deployment

Extension for device
management

Application Leve
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SyncML Specifications — More than just XML

Device Description
Framework E

Bootstrapping E

Device Management
Protocol

Device Management
Framework

Synchronization
Protocol

Device Information
DTD

Representation Protocol

Synchronization Framework

HTTP

OBEX

WSP

Transport Technology
Bindings
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Representation Protocol - Objective

Container Element

SyncML Message

1.  Specifies the structure of Container Element

I SyncML Header

SyncML messages

2. Defines a vocabulary to
describe management data
and operations

3. Core component of the
SyncML framework on which SyncML Body

all others components are et deseriton loments
based o
We will cover them in this order: E
«Common Use Elements H

*Protocol Management Elements

-Command Elements Protocol Management I

*Data Description Elements

‘Message Container Elements

Container Element
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Protocol Management Element(s

<MsgID>1</MsglID> <
<Get> “
<Item>
<Target> <LocURI>./Contacts/John</LocURI> </Target>«
</Item>
</Get>
Management Operations
(one SyncML Message)
| —
<

Agent

Result for each operation

Manager  <Status>
<CmdID>4</CmdID>

<MsgRef>1</MsgRef> <«

&
<«

<Cmd>Get<Cmd> <
<TargetRef><LocURI>./Contacts/John</LocURI> </TargetRef>«
Status Code +——»<Data>401</Data>

</Status>
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Command Elements —functional classification

1. Data Command Elements — used to change application data

Add - creates a new interior node

Copy —copies values from a node to another at the client side
Delete — deletes a node (and all its subnodes)
Exec — process execution on the target

Replace — overwites value for an existing node
Get — retrieves data from the target

1. DataStore Command Elements — Actions for an entire datastore

Alert — used for notifications, text displays
Results — contains results from a Get

2. Process Flow Commands — enhanced processing control

Atomic — all subcommands must be executed
Sequence — subcommands must be executed in order
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The Duo: Get and Results

<MsglD>1</MsglID>

<Get>

<CmdID>2</CmdID>

<Item>

<Target> <LocURI>./Contacts/John</LocURI> </Target>
</Item>

</Get>

e .
BoRAnBBASARRALS BRA RodR
s2p

o

aaaaaaaaaaaaaaaaaa
aaaaaaaaaaaaaaa

<Results>

<MsgRef>1</MsgRef>

<CmdRef>2</CmdRef>

<CmdID>2</CmdID>

<Item>

<Source> <LocURI>./Contacts/John</LocURI> </Source>
<Data>Tel:01564433</Data>

</Item>

</Results>
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Data Description Elements

. <Data>....</Data> encloses SyncML payload data

. <ltem>....</ltem>

« isolates a command from the underlying data

« Contains Data, Identification and Metadata

. <Meta>.....</Meta> provides meta-information about the
data

 Type of the data

« Size of the data
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Device Management Framework

Describes the management information and how to access it

ﬁ

U
9

Managed Object

Management Tree

. Framework for

describing
management
information

. Management Tree

. Standardized Objects
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Purpose of the Device Management Framework

@e description framework SyncML

ﬁ Describes methodology for describing managed device

@el specific to an @

@ @ e B
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Managed Device Management Application

models
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Modeling Management Information in SyncML

<IELEMENT Node (NodeName, Path?, RTProperties?, DFProperties, (Node* | Value?))>
<IELEMENT NodeName (#PCDATA)>

<!IELEMENT Path (#PCDATA)>

<IELEMENT Value ({PCDATA)>

<IELEMENT RTProperties (ACL, Format, Name, Size?, Title?, TStamp?, Type?, VerNo?)>
<IELEMENT ACL (#PCDATA)>

<IELEMENT Format (b64 | bool | chr | int | node | null | xml)>

Dynamic self-described management
information A

XML Tree Node captures information @ _
about :
‘Name of the managed object
*ACL
*Subtrees @ @ @
‘Value
‘Data Type of the Managed Object

| Management Information
© MADYNES 2003 _17-




Framework properties of a Managed Object

DFProperties

AccessType

DF Type

|

Which operations are possible ?
Add, Copy, Delete, Exec,
Get, Replace

|

Mime type
of the node value

DFFormat

|

Data Format of the
node

Eg. bool, chr, int,
node, null, xml

Framework properties do not change at run-time.
Analogous to a MIB2 definition

Occurence

Description

|

Description of the node

@ MADYNES 2003
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Runtime Properties of the Managed Object

ACL If used, indicates ACL

RTProperties ——
Node Name Same as NodeName

NodeName

Format | Format of the value

Size Size of the node in bytes

TS'I‘amp Timestamp of last change

Type type of the node

Objective : Describe instantiated Managed Object
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Access Control Lists (ACL)

ACL Property regulate access to a MO

| ACL A |

e ACL B

Get=Server A&Replace=Server B |

AcLCc | [ ACLD |
ﬁ ﬁ ACL operation
1. Internal Nodes — access to ACL i1s
regulated by the ACL itself
Q Q 2. Terminal Nodes — Parent Node ACL
regulates ACL modifications
- H 3. If ACL empty then closest ancestor
Server B ACL 1s used

Server A
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Addressing Object Values and Properties

Addressing node values : @

Object is 1dentified by complete path to the root of the management tree
Example : <LocURI>NodeA/NodeB</LocURI>

Extended usage of the tags:

Meta, Format, Type Meta to indicate metainformation
Format (string in this example) for the data format via
<Meta> Runtime property Format
<Format>chr</Format> Type =value for the Mime type
<Type>text/plain</Type>
</Meta>

Addressing Property values : node URI+?prop=<property name>
Example : addressing ACL property of Node B : /SyncML/NodeA/NodeB?prop=ACL
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Device Management Standardized Objects

Mandatory Device Management Objects for any SyncML device

Management Information Regarding :

1. Connectivity information (protocol
IPv4/IPV 6, addresses, ports)
Accepted authentication methods
Bearer type (eg. Obex, GSM, CDMA)
Management server 1D

Manufacturer ID,

Model and Device ID

Software version

A O

Think MIB 2 for device management.....
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Requirements for the Device Management Protocol

Requirement: Ability to deal with dynamic environments

Management Traffic

Dynamic network connectivity

Unreliable communication
medium

Management
Application

=]

Not always on-line devices due
to out of coverage or limited

mobility management

N
Forelgn Access ii

Home Network

Limited incoming connections

for devices

@ MADYNES 2003
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Design choices for the Device Management Protocol

1. Session Oriented

2. Client initiated < Noftification
3. Out of band notification i | want to manage you ! Q

support
Management
4. XML encoded < Session >
5. User interaction enabled Client initiated
Rationale

1. Devices might not be always online

2. Most firewalls will allow only device initiated connections
3. Notification support needed for “server initiated “ sessions
4. User might have other priorities
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A Management Session

: Q Server
i Package 0
Optional Notification A ﬂzgfa;g;ﬂmgg:g;ﬁ §§§ gggg
Pack 1
Cllent Client ir?ict:iaa:(g: session ] .
—> Five logical packages

Package 2
Server initiatialisation+mgt
requests

In most cases one package is a

Packags 3 } SyncML message
Results (for mgt requests)
S *Oversized packages can be included
<:M9”*q_t| In several message
Package 3 . .
Results (for mgt requests Protocol state (each site) s

determined by current protocol

Package 4
Mgt. Requests

Package 3
Results (for mgt requests)
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Security in SyncML Management

Device

Package 0
Optional Notification

Authentication of Server
Integrity check of the message
(MD5/basic authentication)

Two way authentication
Integrity check of the
message

Access Control List
mechanism

Confidentiality provided by
transport level

(HTTPS, SSL, OBEX)

@ MADYNES 2003
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Existing Implementations

Proprietary implementations :
Major actors and contributors to the standard.
Open Source :
Sync4d (http://syncdj.sourceforge.net) for the data
synchronization.
No device management functionality.

LORIA/MADYNES :

SyncML Agent toolkit (www.madynes.org/software)
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MAD-MAX —Overall functionality

Device Description Framework

Methodology for describing device
information models

Device Specific Information

Model
uses

Management Protocol

Managed Device

Package 0
Optional Notification

= =

Package 1
Client initiates session

Management Tree

Package 2
Server authentication+mgt
request:

/MgtTree

Package 3
Results (for mgt requests)

= s

/MgtTree/Vendor

/MgtTree/Vendor/
Ring_signals

Package 4
Mgt. Requests

Package 3
Results (for mgt requests)

1 =

/MgtTree/Vendor/
Ring_signals/Beep

~/

&

Package 4
Mgt.

Package 3
Results (for mgt requests)

NN N

Management Application

Example of a SyncML message

<SyncHdr>

<SyncBody>
<Status>
<CmdID>5</CmdID>
<MsgRef>2</MsgRef>
<CmdRef>0</CmdRef>
<Cmd>SyncHdr</Cmd>
<Data>212</Data>
</Status>

<Results>
<CmdID>6</CndID>
<CmdRef>1</CmdRef>
<MsgRef>2<MsgRef>
<Cmd>Get</Cmd>
<item>
<Source>..</Source>
<Data>Returned value</Data>
<Item>

</Results>

<Final/>

© MADYNES 2003
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MAD-MAX Functional Architecture

Agent Toolkit Syncl:\l/\l/l(l). DM
Extension Devicelet
DM Tree
Fact
*h Browser Manager actory
HTTP Adaptor || l ? *ﬁ
ﬂ g Custom
H B Devicelets
DM DM Tree Manager
Protocol g f
E— Engine || ustom
—D ’ . Devicelets
TCP Adaptor 0 —
ﬁ t Custom
Security Extendible Devicelets
=) Manager Agent —
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The Protocol Engine

Package 2

\ / ( Process Package 2 from
2 SEmNer
) Authenticate
Server

Package1

Create Message
for Package

Deliver Package1

Package 3
Process Management YES Server
Operations authenticated

NO ( Package 3 message with >

( Server no-authorization
£>R‘=" Sizeﬁ‘(sES Create 1 message
1 message for Package 3

< Create rilfkiple Deliver

messages for package3 / ' Package3

YES
Package 4
- I/ Process individual
itional e
Operation &

NO

Protocol state machine design and implementation
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DM Tree Browser

File Tools
[~ MgrmtTree -
(Y verDTD: 1.1.1
[y Man : —-The device manufacturer
[ mod : --The device madel--
% Tl sl
% CJ DMAc
Lo |
[y Addr
() AddrType|
[ Portbr
D Conkef
D Serverld
D SerwerP il
[ serwerionce
[} Userkarme
[ ClientPyw
D ClientMonce
[y AuthPref
[y Marne

NodeMame : AddiType
Path : ./SyncML/ DMAcc f AddrType
RTProperties
ACL: Get=127.0.0.1&
Format : chr
Name : AddrType
Size: 4
Title : The current address type.
TStamp : 07222003
Type : text; plain
VerNo: 1.1
DFProperties
AccessType : Add - Get -
DefaultValue : IPv4
Description : The current address type.
DFFormat : chr
Occurence : One
Scope : Permanent
DFTitle : The type of address specified
DFType : text/ plain

. Value : IPv4
-

NodeName :

Path :

RTProperties
ACL:
Format :
Mame :
Size:

Title :
TStamp :
Type:

Type Value :
VerNo :

DFProperties
AccessType :

Defaultvalue :

AddrTywpe

e LDMACC fAddrTwpe

Cet=127.0.0.1&4Add=152 168.0.1

Char -

AddrType

4

The current address type

07242003

@ MIME ) DDFname

text/plain

11

i Add ® Copy [ Delete
) Exec ™ Get () Replace

IPwd

Description : The current address typoe
DFFormat : Char -
Occurence : One -
Scope: @ Permanent ) Dynamic
DFTitle : The type of address specified in the
DFType: @ MIME ) DDFname
DFType: text/plain

Value : IPwd

Ok Cancel

@ MADYNES 2003
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Extensibility

-factory SyncMLFactoryManager
DMFactory (from DeviceMgmt)
(from DeviceMgmt)
% -factory
GenericDMFactory . ImplAction
(from DeviceMgmt) [ ~aetion->1 (from DeviceMgmt)
ACL AccessType
(from DeviceMgmt) (from DeviceMgmt) . .
GenericlmplAction
(from DeviceMgmt)
-$currentNode
-acce
-acl
DMTreeNode SyncMLToolkit
) . -
(fram DeviceMgmt) (from DeviceMgmt) Stookd
-parent
4 SyncMLAgent
DMTree ree
(from DeviceMgmt)
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Extension Mechanisms

SyncMLToolkit

X

Devicel\dgn ufacturer

- . - DMTree - DMTreeMNode - ImplAction
GenericDMFactory SyncML FactoryManager
: regis&erFa ctory
H ' addFactory
E addNode
getimplAction
GetOperation

|_| getOperation

© MADYNES 2003
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Benchmarks — Encoding strategies

One message with several requests versus several individual messages

Management Bandwidth
—— Managenent Traffic for one global message
Management Traffic for one request per message
450000
400000 e
350000
300000
250000 e
200000
150000 ]
|
100000 K —
50000 ) ,./.7.‘5././.’
0 Ly S ‘ ‘
1 50 100 10 200 250 300 350 400 450 500 550 600 650 700
Number of management requests
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Bandwidth efficiency

Experimental efficiency assessment

Bandwith overhead

3.5

*—0—0—0 ¢

3 | o o
—&— Bandwith overhead

) 2.5
Bandwitdth
ratio

0.5

0 ;

Nunmber of management requests

1 50 100 150 200 250 300 350 400 450 500 550 600 650 700
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Benchmarking the latency

One message with several requests versus several individual messages

Response Time Analysis

—— Response Time for one global message Response Time for one request per message

7000

6000

5000

4000

3000

2000 & /./.‘s.\.*\l

1000

1 50 100 10 200 250 300 350 400 450 500 550 600 650 700

Number of management requests

Time is Money ©
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SyncML DM summary

. SyncML DM is more than just XML based configuration
. Framework for describing management information
. A set of standard Managed Objects
. Transaction oriented Management Protocol
. Network level transport agnostic
. Flexible Access Control

. Adaptation of conceptual design approaches from the SNMP
framework towards device mobility
— Similar building blocks to the SMI, MIB2 and SNMP and Get/Set semantics
— Reversed roles : a managed Device initiates a management session
- Power for the users : allow/deny management actions

. What to expect
— More OpenSource implementations
- Interoperability studies
- Performance analysis and large scale deployment tests
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